LABORATORY CHAPTER №6

TOPIC. MICROSOFT EXCEL

Microsoft Excel table processor is one of the software tools that can be applied for solving a wide class of financial and economic problems. It is used in operations of economists, financiers, marketers, managers, etc., Because a lot of accounting and analytical challenges in front of them, which require tabular data layout and their subsequent analysis, sorting, grouping, summarizing, building charts and graphs.
[image: ]

1. The File menu: This menu allows you to create, save, open and print spreadsheets.
2. Quick access toolbar: You can customize this toolbar to include all of the functions you use most, such as save and undo.
3. The ribbon: The ribbon contains all the office menus and toolbars. The ribbon is divided into tabs, each of which contains groups of controls.
4. Columns: Label 4 is one of the columns in the spreadsheet. Each column is labeled by the letter (or a string of letters) at the top of it.
5. Rows: Label 5 is one of the rows in the spreadsheet. Each row is labeled by the number to its left.
6. Cells: A cell is the intersection between a row and column. A cell is where most of the excel data is entered. A cell’s address is the row and column it is in, for instance, the boxed cell (label 6) is in column E and row 13; hence, its address is E13.
7. The worksheet toolbar: An Excel file is called a workbook. It consists of a number of spreadsheets (worksheets). This toolbar allows you to move between the different spreadsheets in a workbook. It also allows you to create new worksheets, delete existing spreadsheets, and rename sheets.

Data input and data editing
Data can be entered directly into the cell or in the formula bar.
1. Select the cell.
2. Type the data directly in the cell or in the formula bar.
3. Confirm your entries. Confirm your input can be in one of three ways: press the Enter or Tab; press the Enter button (check mark) in the formula bar, select any other cell in the spreadsheet (can not be used when you enter a formula).
4. The same data can be entered simultaneously in several different cells of a single spreadsheet. To do this, select the cells holding Ctrl button into which you must enter the data (not necessarily adjacent), enter the data and press the keys Ctrl + Enter or while holding down the Ctrl key, click on the Enter button in the formula bar.

NOTE: Microsoft Excel usually detects data entered into a cell (text, number, date, time) and automatically sets the appropriate data format. For replacement just select the contents of the cell, enter the new data and confirm. It will be appreciated that when entering certain types of numeric data (date, time, number of bits delimited, percentages, etc.). Data format is automatically set in the cell. Entering the new numeric data exist together can cause them to display incorrectly. Thus, if the date has been previously introduced into the cell, after the input of a conventional Microsoft Excel converts it to date. In this case cell format must be cleaned.

The auto-complete feature allows you to fill cells with data based on a template or data in other cells.
1. Select one or more cells that you want to use as the basis for filling other cells.
2. For example, if you want to set the sequence 1, 2, 3, 4, 5 ..., (days of the week sequence) enter the values 1 and 2 (for days  type Monday and Tuesday) in the first two cells. If you want the sequence 2, 4, 6, 8 ..., enter 2 and 4.
3. If the sequence is 2, 2, 2, 2 ..., enter the value 2 only in the first cell.
4. Drag the fill handle [image: Ð�Ð°Ñ�ÐºÐµÑ� Ð·Ð°Ð¿Ð¾Ð»Ð½ÐµÐ½Ð¸Ñ�] (Move the mouse to the bottom right edge of the cell - it will become a plus).
5. If necessary, click the AutoFill Options icon [image: Ð�Ð·Ð¾Ð±Ñ�Ð°Ð¶ÐµÐ½Ð¸Ðµ ÐºÐ½Ð¾Ð¿ÐºÐ¸] and select the appropriate option.

To perform the calculations 
1. Select the cell where you want to enter a formula.
2. Type = (equal sign). Every calculation in Excel must starts with = sign.
3. Select the cell with the mouse, which is the argument of the formula.
4. Enter the operator sign.
5.Select the cell with the mouse, which is the second argument to the formula.
6. If necessary, continue entering characters operators and selection of cells.
7. Confirm the entry of the formula in a cell, press the Enter or Tab or Enter button (check mark)  
    in the formula bar.

NOTE: With an absolute address  symbol $ may vary addressing mode cells. For example, $A8 means that only when moving the formula addressing rows will vary, and when referring to A$8 - only column addressing.
Editing already entered a formula can be one of the following methods:
· double-click the cell to directly start editing it;
· select the cell, press F2 and edit directly in the cell;
· select the cell and edit the contents of the input line.

To perform the calculations in the tables using built-in formulas
Function - the standard formula, which provides the performance of certain actions on values, 
acting as arguments. Functions can simplify the formula, especially if they are long or complicated. To create a formula with functions commonly used group of Formula Library tab functions.

[image: Ð�Ð°Ñ�Ñ�Ð¸Ð½ÐºÐ¸ Ð¿Ð¾ Ð·Ð°Ð¿Ñ�Ð¾Ñ�Ñ� microsoft excel formulas menu]

1. Select the cell where you want to enter a formula.
2. Click on the required category of functions in function group library and select the required function.
3. In the Function Arguments in the appropriate field(s), enter function arguments.
4. In the Function Arguments, click OK.
To select the required function, you can use the Insert Function (Function Wizard) when working on any tab.
[image: Ð�Ð°Ñ�Ñ�Ð¸Ð½ÐºÐ¸ Ð¿Ð¾ Ð·Ð°Ð¿Ñ�Ð¾Ñ�Ñ� microsoft excel function wizard]

NOTE: By default cell references in formulas are relative, that is, a cell address is determined based on the location of the cell with respect to cell formula. In some cases, the use of relative references inadmissible. In order for the cell reference does not change when you copy, you must use absolute links. An absolute cell reference is the format of $x$y ($A$1, $D$4 ,etc.), where $ - special character, showing an absolute reference.



ADDITIONAL TASK FOR MASTERING SKILLS

In this exercise, you will create an amortization table (monthly basis) that shows your payment, how much went as interest, how much principal was paid, and the amount you owe to the bank. The primary concept in preparing this table is that, each time you make a payment, you have to pay interest on the outstanding borrowed amount, called Principal. The amount that exceeds the interest amount paid reduces the principal before the next payment. Before we proceed into the detailed calculations, we have to set up a spreadsheet for your loan.
1. Click on the cell A1 and type “Loan Amortization Table”.
· It can be observed that the cell width is insufficient to fit the contents of the cell. To adjust the cell size, move the cursor to the area (shown in Figure 1) and click and drag to resize the cell width. Alternatively, you can double click in the area to automatically adjust the cell width to fit the contents.
· Make the font bold; this is the heading for the worksheet. Combine cells A1 and A2 and place heading in the center: Home - Combine and place in center button (Главная – кнопка Объединить и поместить в центре) Every worksheet should have a heading; this is not a necessity, but it is recommended to keep the spreadsheet organized.
[image: ]
Figure 1
2. Click on cell A3 and type “Loan Amount”, “APR” in cell A4, “Loan Term” in cell A5, “Payments/year” in the cell A6. These are called labels. If the worksheet is filled with numbers, it will be difficult for the user to understand it. So, we give names to each number to communicate with the end user what each number means. Always use appropriate labels.
3. Enter the values: 25000 in cell B3, 6% in B4, 5 in B5 and 12 in B6.
Now additionally format the cells to make them more presentable. Since the loan amount is in dollars, we should tell Excel that the number in cell B3 is currency.
4. Right click on the cell B3 and then click on the “Format cells” (Формат ячеек) option. Click on the “Numbers” (Число) tab and choose “Currency” (Денежный) and click OK.

[image: ]
Figure 2

a) [image: ]Change the cells color (green for example), text size to 13pt in range B3:B6 and make the labels bold. It was made to differentiate the input values from the results.
In this example APR is 6%; therefore, the interest rate for each month would be (6/12) = 0.5%. The loan term is 5 years; hence the loan will be repaid in 12*5=60 payments. We should add this additional information into the spreadsheet with appropriate labels.
5. Enter “Total payments” in cell A7 and in cell B7 enter the formula “=B5*B6” (without quotes).
6. Type “Periodic Interest Rate” in cell A8 and in cell B8 enter the formula “=B4/B6” (without quotes).
a) To ensure that your number displays as a percentage, Right click on cell B8, select “Format Cells” (Формат ячеек), Click on the “Number” (Число) tab, Select “Percentage” (Процентный) and change the “Decimal places” (Число десятичных знаков) to 1 as shown in Figure 3.
[image: ]
Figure 3
Finally calculate the monthly payment amount from the periodic interest rate, principal amount and total number of payments. The payment per month can be calculated using the formula:


[image: ]
7. Enter “Payment amount” in cell A9 and enter the formula “=B3*B8/(1-((1+B8)^-B7))” (without quotes)in cell B9. This number is currency, so follow the instructions as before and change the cell to display the value as currency:
[image: ]
Now set up the spreadsheet to calculate the payment information for every month. This should calculate the interest for each month based on the principal, the amount of money paid towards the principal after subtracting the interest amount and finally the principal amount after the payment.
8. Set up the spreadsheet as shown in Figure 4.
[image: ]
Figure 4 Setting up the spreadsheet to calculate periodic payments

To ensure that your text fits the cells, you should select the cells and right click on them and choose the “Format cells” (Формат ячеек) option, click on the “Alignment”(Выравнивание) tab and check the “Wrap text”(Перенос текста) option. The text you entered into the selected cell will automatically fit into the cell.

[image: ]

9. The principal amount for the first payment is simply the same amount that was originally borrowed from the bank. So enter the formula “=B3” in the cell C12.
The interest on this amount is calculated using the simple interest formula i.e. “Principal amount before payment * periodic interest rate”. The periodic interest rate is the same for every month; therefore, we must use an absolute address when we use the periodic interest in the formula. By using the absolute address, we make sure that the input value does not change when we copy the formula.
Absolute addressing can done by explicitly typing two dollars signs in front of a cell address or by pressing F4. Two dollar signs imply that the cell copied along a row or column will have a fixed value. However, if you put just one dollar sign in front of an address (e.g. $F8) then the column indicated by F will stay constant but the row numbers will change. On the other hand if you put a dollar sign in front of the number (e.g. F$8) then the row number 8 will remain constant and the columns will change automatically when you copy.

10. [image: ]In first row of Interest column set formula : “=C12*$B$8”, as follows:
11. Subtract the interest from the monthly payment of $483.32 to calculate the amount paid on the principal. Use absolute addressing when reference the cell with monthly payments, as this stays constant throughout the calculation, as follows:
[image: ]

12. Finally, subtract the “amount paid on principal” from the “principal amount before payment”. This will be principal amount for the next month’s payment:

[image: ]
This completes the calculation for the first payment. Now we can calculate the amount of interest and principal paid by the second payment.
13. The principal for the second payment is equal to the principal amount after the first payment. So enter the formula “=F12” in C13.
[image: ]
To calculate the rest of the entries in this table, all we have to do is copy the formula for cells D12 to F12.
14. Select the cells for D12 to F12 and move your mouse to the bottom corner of the selected cells as shown in Figure 5.
[image: ]
Figure 5
a) When the mouse arrow turns to the + button, click and drag to the next row. This will calculate all the entries for the next payment.
[image: ]

Calculating the next 58 entries is a breeze, as we just have to copy the formula from cells C13 to F13 and paste it in the next 58 cells either by using the copy-paste method or the click-and-drag method. In the copy-paste method, select all the cells from C14:F14 to C71:F71, right click on the cells and choose paste. However, when using the click-and-drag method, all you have to do is to select the cells C13 to F13 and click at the bottom corner, then drag down to C71:F71 cells. Excel will automatically fill all the entries for the next 58 payments. Figure 6 shows the amortization table for the first 10 payments.

[image: ]
Figure 6 Completed loan amortization table for the first 10 payments.

Notice that the table was already configured to show the $ sign for the all entries. Ensure that proper formatting is followed to improve the appearance and readability of the table.

Task №2. Working with formulas on different worksheets

1. On a new list create table as follows (table 3):
Table 3
	
Issuer
	Nominal share KZT.
	Selling price KZT.
	Dividends declared per year
	
Yield of shares for dividends

	
	
NA
	
CP
	
% Div
	
DivR
	To face value, DN
	Actual
DF

	KazKom
	10000
	17780
	400
	
	
	

	Halyk Bank
	10000
	22900
	400
	
	
	

	Bank os Astana
	5000
	5600
	320
	
	
	

	OilBank
	1000
	2015
	653
	
	
	

	Sberbank
	1000
	2482
	736
	
	
	

	KB AKKorda bank
	1000
	1000
	325
	
	
	

	SKB Bank
	50000
	27050
	360
	
	
	

	Engine Bank
	1000
	1200
	1535
	
	
	



2. In the corresponding columns, enter the formulas for calculating the output indicators:
· DivR(i) = NA(i)*Div(i);
· DN(i) = DivR(i)/NA(i);
· DF(i) = DivR(i)/CP(i),
where i  is the number of the issuer.
3. Create a new table on the new sheet (table 4):
Table 4
	Parameter
	Value

	Average selling price of shares
	

	Maximum selling price of shares
	

	Minimum selling price of shares
	

	Average actual return on shares
	

	Maximum actual return on shares
	

	Minimum actual return on shares
	



4. On the basis of the original document (Table 3), fill in Table 4 (by the columns «Selling price» and "Actual DF"). You can get access to the same functions in different ways:
a. Average selling price of shares for all issuers - click on the corresponding cell in the "Value" column of Table 4, then menu Formulas (Формулы) -> More functions (Другие функции) -> category Statistical (Статистические)-> function = AVERAGE. Click on the field “Number 1” (Число 1) Select the cells of the "Selling price" column with values (Table 4). In the Number 1 row of the Function Arguments window, the beginning and end addresses of the data in this column are displayed, separated by a colon (example C3:C10). Click the OK button;
b. Maximum price for the sale of shares for all issuers - click on the corresponding cell in the "Value" column of Table 4, then menu Home (Главная) -> Auto Sum Σ (Авто сумма, символ Σ on) -> MAX (Максимум). Select the cells of the "Selling price" column with values (Table 4) ->Press Enter.
c. Minimum selling price of shares for all issuers - click on the corresponding cell in the "Value" column of Table 4, then Insert function (symbol fx to the left of the formula bar) (Мастер функций, символ fx слева от строки формул) -> category Statistical (Стастистические)-> function = MIN (Мин). Click on the field “Number 1” (Число 1) Select the cells of the "Selling price" column with values (Table 4). In the Number 1 row of the Function Arguments window, the beginning and end addresses of the data in this column are displayed, separated by a colon (example C3:C10). Click the OK button.
5. Repeat steps 4.1 - 4.3 to calculate the corresponding column values for the “Actual DF” field.
6. In the source table, sort the entries in ascending order of the actual dividend yield (select the "Actual DF" column, execute the Data menu command Sort (Данные - Сортировка)).
7. Filter table by selecting only those issuers whose actual yield is greater than the average for the table. The filtering algorithm is as follows:
a. Highlight the data of the “Actual DF” field (including column title) - Data menu – Filter (Данные - Фильтр). A filter is displayed on the column(down arrow). 
b. Click it and select Numeric filters (Числовые фильтры) - Above average (Выше среднего).
8. Copy the filter results on the new worksheet, including the following fields:
· Issuer;
· Nominal share KZT;
· Selling price;
· Yield of shares for dividends (Actual DF).
9. Create a circular diagram on an new Excel worksheet that reflects the actual dividend yield of each issuer in the corresponding sector:
a. Select columns "Issuer" and "Actual Yield", then menu command Insert -> Chart (Вставка – Диаграмма -Круговая).
b. Left-click the mouse on the diagram (select it) - the menu Design (Конструктор) - Move the chart (Переместить диаграмму) - On a separate sheet (На отдельном листе).
10. Create a mixed chart at a new list, in which, in the form of histograms, represent the value of the Nominal share and the selling price of the shares of each issuer, and show their actual yield as a linear graph on the same chart:
a. Highlight the columns "Issuer", "Nominal share" and  "Selling price";
b. Menu Insert -> Chart -> Bar chart (Вставка- Диаграмма - Гистрограмма);
c. [bookmark: _GoBack]To add a line chart "Actual dividend yield", right-click on the "Design - Select Data (Конструктор- Выбрать данные), select the Add (Добавить) button, in the Name field (Имя ряда) enter the name of the "Actual DF", select Values (Значения) and select cells with values of actual DF field.
d. On the resulting diagram, place the mouse pointer on the column corresponding to the value of " Actual DF ", right-click on the context menu, select the Type of chart (Изменить тип диаграммы) command, where you can select the chart type – Graph (График).

Task 3. Creating of graphs on parametric formulas.

1 On the new spreadsheet, build a table as follows (Table 5).
To add a superscript / subscript text, select the text (which will accept the superscript / subscript) in the formula bar and click the font adjustment button on the Home menu tab and mark the point of the superscript (Надстрочный). 
To perform the operation of raising to the power in the formula, we use the sign of ^ (for example, x ^ 6 - raising x to the 6th power). 


[image: ]




Таблица 5
[image: ]

2 Build the progression in the first line - the values of x. The range of values for x [1:20], step = 0.46. Home - Fill – Progression (Главная – Заполнить - Прогрессия).
3 Calculate the values of the functions Y, Z, A, B, average, maximum and minimum values.
a. To calculate the values, enter the corresponding formula in the cell for x = 1 and calculate for the remaining values using the autocomplete of the formulas.
4 On a separate spreadsheet, draw diagrams (dot graphs Точечный график) for the values of X, Y, Z, A, B. Name the diagram (graph of parametric functions) and the name of the X axis.
5 For the X axis, set the step to 2 units
· Select the axis - left click on the axis. Call the context menu - Axis format(Формат оси).
· In the "Interval unit" (Интервал) category, set 2.
6 Sample of the work result:

[image: ]
Task 4. Creating of the graph of the three-dimensional function.

1. Construct a graph of the function z = x2 + y2.
2. Set the values for the variables x and y in the range from -2 to 2 in steps of 0.1.

3. In cell B3, enter the formula for z = x2 + y2. In this case, you need to use mixed links to easily copy this formula to the entire range of cells:
To ensure that the cell does not move when you copy a formula on a line or column, you need to fix it. To fix cells, use absolute (fixed by column and row) and relative (fixed either by row or by column) addressing.
To fix a column and / or a line in front of its name, put the $ symbol.
Absolute addressing: $ B $ 7 - cell B7 is fixed - when copying the formula in which this cell participates, its address will not change either when copying on the line or when copying by the column.
Relative (mixed) addressing: $ C2 - Cell C7 is assigned to a column. When you copy a formula in which this cell participates in a row, its value will always be in column C, and when copying by a column, the line will change. D $ 3 - cell D3 is fixed on the line. When you copy a formula in which this cell participates in a column, its value will always be in line 3, and when copying by a row - the column will change.

4. Copy the formula to the entire range of cells.



















5. To build a three-dimensional graph, select the range of values for z and select the type of the "Wire surface" diagram (Вставка – Диаграмма – Проволочная поверхность).
[image: ]6. Result will be as follows:
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